PATROL® Knowledge
Module for Microsoft
Windows Active Directory
Getting Started

Version 1.5

January 20, 2003

<bmesoftware



Copyright 2003 BMC Software, Inc. All rights reserved.

BMC Software, the BMC Software logos, and all other BMC Software product or service names are registered
trademarks or trademarks of BMC Software, Inc. All other trademarks belong to their respective companies.

PATROL technology holds U.S. Patent Number 5655081.

BMC Software considers information included in this documentation to be proprietary and confidential. Your use
of thisinformation is subject to the terms and conditions of the applicable End User License Agreement for the
product and the proprietary and restricted rights notices included in this documentation.

Restricted Rights Legend

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED -- RIGHTS RESERVED UNDER
THE COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer
software by the U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14,
DFARS 252.227-7013, DFARS 252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended
from time to time. Contractor/Manufacturer is BMC Software, Inc., 2101 CityWest Blvd., Houston, TX
77042-2827, USA. Any contract notices should be sent to this address.

Contacting BMC Software

You can access the BMC Software Web site at http://www.bmc.com. From this Web site, you can obtain
information about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada Outside United States and Canada
Address BMC Software, Inc. Telephone  (01) 713 918 8800

2101 CityWest Blvd.

Houston TX 77042-2827 Fax (01) 713 918 8000

Telephone 713 918 8300 or
800 841 2031

Fax 713 918 8000



http://www.bmc.com

Customer Support

You can obtain technical support by using the Support page on the BMC Software Web site or by contacting
Customer Support by telephone or e-mail. To expedite your inquiry, please see “Before Contacting BMC
Software.”

Support Web Site

You can obtain technical support from BMC Software 24 hours aday, 7 days aweek at
http://lwww.bmc.com/support.html. From this Web site, you can

*  read overviews about support services and programs that BMC Software offers

«  find the most current information about BMC Software products

e search adatabase for problems similar to yours and possible solutions

e order or download product documentation

e report aproblem or ask a question

*  subscribe to receive e-mail notices when new product versions are released

»  find worldwide BMC Software support center locations and contact information, including e-mail addresses,
fax numbers, and telephone humbers

Support by Telephone or E-mail

In the United States and Canada, if you need technical support and do not have access to the Web, call

800 537 1813. Outside the United States and Canada, please contact your local support center for assistance. To
find telephone and e-mail contact information for the BM C Software support center that services your location,
refer to the Contact Customer Support section of the Support page on the BMC Software Web site at
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Before Contacting BMC Software

Before you contact BMC Software, have the following information avail able so that Customer Support can begin
working on your problem immediately:

e product information

— product name
— product version (release number)
— license number and password (trial or permanent)

e operating system and environment information

— machinetype

— operating system type, version, and service pack or other maintenance level such as PUT or PTF
— system hardware configuration

— seria numbers

— related software (database, application, and communication) including type, version, and service pack or

maintenance level
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sequence of events leading to the problem
commands and options that you used
messages received (and the time and date that you received them)

— product error messages
— messages from the operating system, suchasfi |l e system ful |
— messages from related software
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Product Components and
Capabilities

This chapter provides a brief overview of the PATROL Knowledge
Module for Microsoft Windows Active Directory product.

The following topics are discussed in this chapter:

Active Directory Monitoring ............
Managed Systems .................
Replication Monitoring . ............
FSMO Monitoring.................
LDAPMonitoring . ................
SAM Monitoring . .................
Address Book Monitoring .. .........
Event Monitoring. .................

Reporting ...........covviiivn...

Related Documentation ................
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Features

The PATROL Knowledge Module for Microsoft Windows Active
Directory product, also known as PATROL KM for Active Directory, lets
you monitor and analyze your Microsoft Windows 2000 Active Directory
environments. Whether you choose to monitor and analyze one
environment or many, PATROL KM for Active Directory helps you

e detect and notify you if Microsoft Windows 2000 Active Directory
generates errors or performs slowly

e monitor performance of system resources

e planfor capacity and availability

» monitor al domain controllers within asite

« monitor al domain controllers between sites within asingle domain

e anticipate and eiminate problems before they become apparent to
users of the monitored Microsoft Windows 2000 Active Directory
environments

For a brief description of product features, see the sections that follow.
For more detailed information about how to use the product and complete
descriptions of the application classes and parameters, see the product
online Help. For afull list of all parameters and their default settings,
consult the PATROL Parameter Reference Manual, which isincluded on
the documentation CD that came with this product.

For information on basic functions of the PATROL Agent and consoles,
refer to the PATROL Agent Reference guide and the release notes for the
PATROL consoles.

Thisguideis not intended as areference for the Microsoft Windows 2000
Active Directory product. Refer to your Microsoft Windows 2000 Active
Directory documentation for further information about setting up
Microsoft Windows 2000 Active Directory.
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Active Directory Monitoring

PATROL KM for Active Directory monitors the performance of managed
systems in a Microsoft Windows 2000 Active Directory environment.
This section defines a managed system and identifies the environmental
elements that PATROL KM for Active Directory monitors.

Managed Systems

A PATROL KM for Active Directory managed system is a Windows
2000 domain controller onto which PATROL KM for Active Directory
has been installed.

A managed system provides aview of its Microsoft Windows 2000
Active Directory environment. Each managed system is responsible for
monitoring Microsoft Windows 2000 Active Directory’s key indicators
that are required to ensure and maintain the consistency of the Directory
data and the desired level of service throughout the Microsoft Windows
2000 Active Directory forest.

Each PATROL KM for Active Directory managed system uses the
application classes shown in “Application Classes’ on page 3-12. For
additional information about these application classes, refer to the
PATROL KM for Active Directory online Help.

Replication Monitoring

PATROL KM for Active Directory monitors the Microsoft Windows
2000 Active Directory replication for errors and latency (to verify that
replication occurs within a reasonable time), both within a site (intrasite)
and between sites (intersite).

Directory replication is monitored at each managed system (domain
controller). This functionality includes monitoring basic replication by
creating synthetic transactions and verifying the replication of those
transactions.
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Intrasite Monitoring

PATROL KM for Active Directory monitors the replication status of the
domain controller upon which it isinstalled. It determines whether
updates from each domain controller within the site have been replicated
successfully and in atimely manner.

Intersite Monitoring

Intersite replication monitoring verifies that Microsoft Active Directory
updates are successfully distributed between sites. Each bridgehead
server in asite is checked to determine if Microsoft Active Directory
updates from other sites have been successfully replicated to the
bridgehead server. The intersite replication interval is automatically
determined at each collection; it requires no configuration. However, if
desired, you can override the automatic replication interval
determination, on a site-by-site basis, by configuring the configuration
database (pconfig) variable,

/ActiveDirectory/Configur ation/<site>/I nter siteReplicationSchedule. See
the online Help for more information.

FSMO Monitoring

Microsoft Windows 2000 Active Directory (also referred to as Active
Directory) supports multi master replication of the Directory data among
al domain controllersin the domain. This allows certain domain
configuration changes to be made at any domain controller in the domain
and automatically propagated to each of the domain controllersin the
domain.
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Some domain configuration changes can only be made from domain
controllersidentified as the operations masters. The operations masters
play various roles. The roles of the operations masters can be moved
between controllers within the domain, and are thus referred to as flexible
single master operations (FSMO). The five FSMO roles are shown in
Table 1-1..

Table 1-1 FSMO Roles and Scopes

Role Scope
schema master forest
domain naming master forest
relative ID master domain
Primary Domain Controller (PDC) emulator domain
infrastructure master domain

The PATROL KM for Active Directory product monitors the availability
of the forest-wide and domain-wide FSMO roles.

LDAP Monitoring

PATROL KM for Active Directory monitors LDAP locally at each
monitored system for

e connection availability
e responsetime

SAM Monitoring

PATROL KM for Active Directory monitors the Security Account
Manager (SAM). SAM provides legacy NT authentication support. SAM
monitoring is inactive by default. To activate SAM monitoring, refer to
“Activating Parameters’ on page 3-11.
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Address Book Monitoring

PATROL KM for Active Directory monitors the performance of Address
Book requests made against the Microsoft Windows 2000 Active

Directory server.

Event Monitoring

To measure the overall health of the domain controllers, PATROL KM
for Active Directory configures the PATROL KM for Microsoft Windows
Servers 3.8.00 to monitor various events pertaining to

« DNS Name Registration

e Core Active Directory Service

» File Replication Service and Group Policy

«  Time Synchronization Service

 Kerberos
« Netlogon

Refer to “ Configuring Windows Event Log Monitoring” on page 3-10 for

additional information.

DNS Name Registration

To identify failures with the DNS name registration, PATROL KM for
Active Directory configures PATROL for Microsoft Windows Servers
3.8.00 to obtain event information, as shown in Table 1-2.

Table 1-2 Monitored Events - DNS Name Registration

Event Log Source Event Significance
System DNSAPI 11154, 11166 domain controller does
not have rights to
perform a secure
dynamic update.
System DNSAPI 11150, 11162 DNS server timed out
System DNSAPI 11152, 11153, | Zone or currently-
11164, 11165 connected DNS server
does not support
dynamic update.
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Table 1-2 Monitored Events - DNS Name Registration

Event Log Source Event Significance

System DNSAPI 11151,11155, A resource record for
11163, 11167 the domain controller is
not registered in DNS.

System NETLOGON 57773 DNS locator record is
not registered because
the primary DNS server
does not support
dynamic update.

System NETLOGON 57774 A domain controller
locator record is not
registered in DNS.

Core Active Directory Service

To identify failures with the core Active Directory service, PATROL KM
for Active Directory configures PATROL KM for Microsoft Windows
Servers 3.8.00 to obtain event information, as shown in Table 1-3.

Table 1-3  Core Active Directory Service Monitored Events

Event Log Source Event Significance
Directory all sources Severity = error | primary error events for
Service Active Directory
System LSASS Severity = error | Local security authority

is the core security
subsystem for Active
Directory.

File Replication Service and Group Policy

To identify failures with the file replication service and group policy,
PATROL KM for Active Directory configures PATROL KM for
Microsoft Windows Servers 3.8.00 to obtain event information, as shown
in Table 1-4.
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Table 1-4  File Replication Service/Group Policy Monitored Events

Event Log Source Event Significance

FRS all sources Severity = error | synchronizes policy
between all domain
controllers in the forest

Application USERENV Severity = error | applies group policy and
User = System | profiles on domain
controllers
Application SCECLI Severity = error | Security Configuration

Engine error messages

Time Synchronization Service

To identify events that may indicate problems maintaining uniform time
throughout the Active Directory forest, PATROL KM for Active
Directory monitors the events shown in Table 1-5.

Table 1-5  Time Synchronization Service Monitored Events

Event Log Source Event Significance
System W32TIME Severity = error | problem maintaining
Severity = uniform time throughout
warning the Microsoft Windows
2000 Active Directory
forest

Kerberos

To identify events that many indicate problems with Kerberos, the default
authentication protocol, PATROL KM for Active Directory monitors the
events shown in Table 1-6.
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Net Logon

Reporting

Table 1-6  Kerberos Monitored Events
Event Log Source Event Significance
System KDC Severity = error | critical Kerberos

Distribution Center
service error messages

To identify events that may indicate problems with Net Logon service
and protocol, which isrequired for proper domain controller
functionality, PATROL KM for Active Directory monitors the events
shownin Table 1-7.

Table 1-7  Netlogon Monitored Events
Event Log Source Event Significance
System NETLOGON Severity = error | critical NETLOGON

5705, 5723

service errors

PATROL KM for Active Directory generates an Active Directory
Operations report, which provides information about Active Directory
with respect to the local domain controller, including information about

the
e server
e gte

e Microsoft Windows 2000 Active Directory configuration
e Microsoft Windows 2000 Active Directory FSMO role holder
e Microsoft Windows 2000 Active Directory lost and found objects
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Related Documentation

For additional information about PATROL KM for Active Directory, see
your online Help and release notes. For information about the PATROL
KM for Active Directory parameters, see the PATROL Parameter
Reference Manual. For additional information about PATROL, see the
following documentation:

e Help for your PATROL Console

* PATROL Console Server User Guide

e PATROL user guides

e PATROL getting started guides

» PATROL Central Operator - WWeb Edition Getting Started

e PATROL Central Operator - Microsoft Windows Edition Getting
Sarted

To view the complete PATROL documentation library, visit the support
page on the BMC Software Web site at
http://iwww.bmc.com/support.html. Log on and select a product to access
the related documentation. To log on if you are afirst-time user and have
purchased a product, you can request a permanent user name and
password by registering at the Customer Support page. To log on if you
are afirst-time user and have not purchased a product, you can request a
temporary user name and password from your BMC Software sales
representative.

The complete PATROL documentation library is also available on the

PATROL documentation CD included with major releases of the
PATROL Console and Agent.
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Installation and Migration

This chapter describes how to install the PATROL Knowledge Module
for Microsoft Windows Active Directory version 1.5.00.

REQUITEMENES . . . ..o e e e e 2-2
SO . e 2-2
LiCeNSE. ..o e e 2-3
Logon Account and Default PATROL Account. . ............ 2-3
PATROL SeCUrity. . ..ot 2-4

Installation Procedures. . ... 2-5
Choosing an Installation Option . ........................ 2-8
Typical Installation Procedure. ... ............ ... ..., 2-9
Custom Installation Procedure. . ...............coivon... 2-11

Migration . ... 2-14

WheretoGofromHere ............... ... . i 2-14
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Requirements
Beforeinstalling PATROL KM for Active Directory, verify that your
environment meets all of the requirements needed to install and operate

PATROL KM for Active Directory. The following sections describe the
system, license, logon, and security requirements.

System

Verify that the target computer meets the installation requirements listed
in Table 2-1.

Note

PATROL KM for Active Directory only monitors Microsoft Windows
2000 Active Directory when Microsoft Windows 2000 Active Directory
is running on domain controllers.

Table 2-1 Installation Requirements

Resource Minimum Requirements
operating systems Microsoft Windows 2000 Server

Microsoft Windows 2000 Advanced Server
PATROL 3.4.00 or later
disk space needed to install NA
disk space used after 25 MB
installation

Note

The PATROL Knowledge Module for Microsoft Windows Active
Directory was built to support Microsoft .NET Server 2003 Standard,
Enterprise, and Datacenter Editions (32 and 64 bit). Since Microsoft
.NET Server was not yet generally available at the time of the rel ease of
this Knowledge Module, please refer to the BMC Support website for a
technical bulletin regarding official support for .NET after .NET Server
2003 becomes generally available.
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License

Verify that you have a valid demonstration license (typically good for 30
days) or a permanent license to run your PATROL products. If you have
not yet installed a permanent license, contact your BMC Software sales
representative or the BMC Software Contract Administration department
for licensing information.

Logon Account and Default PATROL Account

During installation of the PATROL Agent, you are asked to specify the
default PATROL account. This user account is automatically assigned the
rights needed to operate PATROL . BM C Software recommends that you
create a unique user account for the PATROL default. If one does not
aready exist on your machine, see the PATROL installation guide for
your operating system for instructions.

Warning
Do not use the administrator account to install PATROL products. Create
a separate account that has the system administrator privileges. If you use
the administrator account, files created by PATROL will be owned by the
Administrator, and security or file access problems can result.
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PATROL Security

You can secure the data passed between PATROL components and
restrict unauthorized users from accessing your data by implementing
PATROL security. PATROL now contains five security policy levelsin a
predefined set of security configurations that you can select from when
you install PATROL. You can install the least secure or the most secure
features of PATROL, depending on your system needs and the
complexity of securing your systems.

Note
Review the security level definitionsin the PATROL Security User Guide
before installing PATROL to determine the appropriate security level for
your system needs. If you want to implement anew security level after
having previously installed security, you must uninstall your current
implementation of PATROL and reinstall it with the new security level.

High security requires more configuration of the communicating
components (the agent, console, and console server) and is more difficult
to use than lower levels of security. You can select the security level that
best balances the ease of use with your need for security.

Thelowest level (0) isaminimal level of security with no configuration
requirements. At the highest security level (4), al communicating
components must authenticate with each other and key databases must
validate connection requests.

Note

All componentsin a system, including agents, consoles and console
servers, must operate at the same level of security to communicate with
each other. This requirement is ensured when you install PATROL with
the lowest level of security (the default level of 0).
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For more information about implementing and using PATROL security,
see the following documentation:

e PATROL Security User Guide
e PATROL Central Operator - Web Edition Online Help
» PATROL Central Operator - Microsoft Windows Edition Online Help

How PATROL Security Affects KMs

PATROL Security isingtalled as part of the agent, console, and console
server. KMsinherit the security policy from the agent and console on
which they areinstalled.

Installation Procedures

Planning

BMC Software recommends that you install the product on a limited
number of development or test machines first, configure and test the
BMC product, and then install it onto production machines.

Note
Upon installation on a server that has PATROL KM for Domain 1.3.00,

1.4.00, or 1.4.01 already installed, the Domain KM application classes
that are named NT_AD<name> are automatically disabled. These
disabled application class names are recorded in the configuration
database, pconfig, in the location /AgentSetup/disabledK M s.

Theinstallation plan is simple and straightforward: install PATROL KM
for Active Directory on domain controllers that you wish to monitor.

The installation program gives you two installation options
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e instal to the local computer now
e create an ingtallable image on the local computer that you can then
install on the local computer or on other computers at any time

Note

For additional information about installing from the installable image,
refer to the PATROL Installation Reference Manual.

You must install PATROL KM for Active Directory and a PATROL
Agent on each machine that you want to monitor. You also must install
PATROL KM for Active Directory on each machine from which you
want to view results.

Note
The installation program does provide you with the ability to export the
installation package after you have made al of the installation selections.
If you place that installation package in a shared Directory, you can use
that same installation package to install BMC Software products on all
computers that share the same BM C products Directory, PATROL default
login, PATROL Agent port number, PATROL 3.x and 7.x product
directories, and security option.

The installation program shipped with PATROL 3.5 and PATROL 7.1
prompts you to select the roles performed by the computer onto which
you are installing BMC Software products. Before beginning the
installation process, review the following definitions of the roles
presented in the install ation program and decide which of these describes
the roles that each computer in your system performs. During
installation, select one or all of the following options:

e Console Systems (formerly referred to as console computers and
client application system) host user desktop applications such as
consoles, user interfaces, viewers, and browsers. Select this option if
the computer to which you are installing will perform any of the
following roles:

— monitor and manage on the Web using a PATROL Central
Operator - Web Edition console (PATROL 7) (Unix or Windows)
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— monitor and manage on Windows using a PATROL Central
Operator - Windows Edition console (PATROL 7)

— monitor, manage, and develop KMs on Unix or Windows using a
PATROL Console for Unix or PATROL Console for Windows
(PATROL 3)

e Managed Systems (formerly referred to as agent computers) host
software that manages the resources on the system, such asa
PATROL Agent, PATROL Knowledge Modules, and Service
Reporting Retrievers. Select this option if the computer to which you
areingtaling will perform any of the following roles:

— host aPATROL Agent 3.4 or greater (works with both the
PATROL 3.x and PATROL 7.1 architecture)

— host aPATROL Central Operator - Microsoft Windows Edition
(PATROL 7.1) console

— host KMs and components that contain the knowledge PATROL
uses to monitor the resources on this computer.

e Common Services (new with PATROL 7.1) host services that are
shared among managed systems and client application systems. Each
of these common services can be installed on any computer in the
network. Select this option if the computer to which you are
installing will perform any of the following roles:

— host the PATROL Central Operator - Web Edition (PATROL 7.1)
console

— host the PATROL Central Operator - Microsoft Windows Edition
(PATROL 7.1) console.
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Choosing an Installation Option

Use one of the following optionsto install PATROL KM for Active
Directory:

The Typical installation option installs the predefined set of
components (selectable entities). To install components that are not
among the predefined set, see “ Custom Installation Procedure” on
page 2-11.

Note

BMC Software recommends that you use the Typical installation if you
do not yet have a good understanding of PATROL and you are installing
to acomputer that does not have aprior version of PATROL.

Note

The Typical and Custom installations will automatically preload a
predefined set KMs. Thislist is stored in the file
MWD_ACTIVE_Directory MN.kml.

The Custom installation option installs the components and KM s that
you select. Use custom if you have a good understanding of PATROL
or you are installing to a machine that has a prior version of
PATROL.

If you areingtalling a KM to a PATROL 3.4.x environment that uses
the PATROL KMDS, do not use the Custom or Typical installation
options. Perform one of the following actions instead:

— At the Windows command line prompt, from the CD Directory
containing the setup executable, execute
setup.exe -kinds -kmds portnum (default portnumis 3182).

— At the Unix command line prompt, from the CD Directory
containing the setup executable, execute
setup.sh -kmds -kmds portnum (default portnumis 3182).
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Typical Installation Procedure

To perform aTypica installation that includes PATROL KM for Active
Directory, take the following actions:

1. Fromtheinstalation CD, run setup.exe (Windows) or setup.sh
(Unix).

2. When you see the Select Installation Option dialog box, select | want
toinstall productson this computer or | want to create an installable
imageto beinstalled later.

3. If you selected | want to create an installableimage to beinstalled
later, populate the destination path where you want to save the
installable image by using the Browse button or entering the path
into the text box that is adjacent to the Browse button.

4. Inthe Select Type of Ingtallation dialog box, select Typical.

5. Inthe Specify Installation Directory dialog box, identify your BMC
Software products installation Directory.

6. When you see the Select System Roles dialog box, select Managed
System, Console Systems, or Common Services, or some combination
of these.

e Select Managed System if you are installing to a computer that
will host a PATROL Agent 3.4.00 or later.

e Select Console Systems if you are installing to a computer that

will host a PATROL Console or PATROL Central Operator -
Microsoft Windows Edition console.
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e Select Common Servicesif you areinstalling to a computer that
will host a PATROL Console Server, RT Server, or PATROL
Central Operator - Web Edition.

Note
For more information on these products, refer to the PATROL Console
Server User Guide.

7. Inthe Sdect Products and Componentsto Install dialog box, select
the products and components that you want to install (see Figure 2-
on page 2-10).

=

Figure 2-1 Select Products and Components to Install Dialog Box for
Typical Installation

@F‘rnduct selection
=" _-.j PATROL for Microsoft Windows Servers
- W PATROL Agent for Microsoft Windows
= _4|7 PATROL Knowledge Modules for Microsoft Windows

FATROL Knowledge Module for Microsoft Cluster Server

PATROL Knowledge Module for Microsoft COM+

FATROL Knowledge Module for Microsoft Message Queue

PATROL Knowledge Module far Microsoft Metwark Load Balancing
FATROL Knowledge Module for Microsoft YWindows Active Directory
PATROL Knowledge Module for Microsoft YWindows Domain Services
PATROL Knowledge Module for Microsoft YWindows Operating System

= __4|7 FATROL Reporting and Utilities

W PATROL Adapter for Microsoft Office
[T PATROL Cluster Configuration Wizard

U m iR

8. Inthe Provide Information for the PATROL Agent dialog box,
indicate whether or not you want to start the PATROL Agent
automatically after completing the installation (you will seethis
dialog only if you selected Managed System in Step 6 of this
procedure).

9. Complete the remaining dialog boxes.
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Custom Installation Procedure

A Custom installation is similar to the Typica installation. The
differences are listed in the following table.

Table 2-2  Characteristics of Typical vs. Custom Installation

Description Typical Installation Custom Installation
complexity lower higher

automatically preload yes yes

KMs

allows port number no yes

designation

specify PATROL 3.x no yes

Directory location

specify PATROL 7 no yes

Directory location

To do acustom installation

1. Fromtheinstalation CD, run setup.exe (Windows) or setup.sh
(Unix).

2. When you see the Select Installation Option dialog box, select | want
toinstall productson this computer or | want to create an installable
imageto beinstalled later.

3. If you selected | want to create an installable image to be installed
later, populate the destination path where you want to save the
installable image by using the Browse button or entering the path
into the text box that is adjacent to the Browse button.

4. Inthe Sdlect Type of Installation dialog box, select Custom.

5. Inthe Specify Installation Directory dialog box, identify your BMC
Software products installation Directory.

6. When you see the Select System Roles dialog box, select Managed
System, Console Systems, Common Services, or some combination of
these.
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e Select Managed System if you are installing to a computer that
will host a PATROL Agent 3.5.

e Select Console Systemsif you are installing to a computer that
will host a PATROL Console or PATROL Central Operator -
Microsoft Windows Edition console.

e Select Common Servicesif you areinstalling to a computer that

will host a PATROL Console Server, RT Server, or PATROL
Central Operator - Web Edition.

Note

For more information on these products, refer to the PATROL Console
Server User Guide.

7. Inthe Sdect Products and Componentsto Install dialog box, select
the products and components that you want to install (see Figure 2-2
on page 2-13).

8. Inthe Provide Information for the PATROL Agent dialog box,
indicate whether or not you want to start the PATROL Agent
automatically after completing the installation (you will see this
dialog only if you selected M anaged System in Step 6 of this
procedure).

9. Inthe Provide the PATROL 3.x Product Directory, identify the BMC
productsinstallation Directory and the PATROL 3.x product
Directory (you will seethisdialog only if you selected Console
Systemsin Step 6 of this procedure).
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Figure 2-2  Select Products and Components to Install Dialog Box for
Custom Installation

,&F‘rnduct Selection

B PATROL for Microsoft Windows Servers
B __q|7 PATROL Agent for Microsoft Windows

..... :1J ¥ PATROL Agent for Microsoft Windows Servers

..... ] I PATROL Perform Agent Debug Symbals
..... o] [T PATROL Petfarm Agent for Micrasoft Windows Servers
..... = [T PATROL Perform ARM Support

- __\JF FATROL knowledge Madules for Microsoft Windows
: PATROL Adapter for WBEM

=
..... o] I PATROL Knowledge Maodule for Event Management

..... ] [ PATROL Knowledge Maodule for Histary Loader

..... o] W PATROL Knowledge Module for Log Management

..... ] [T PATROL Knowledge Maodule for Microsoft Cluster Server

..... o] ¥ PATROL Knowledge Module for Microsoft COM+

..... ] W PATROL Knowledge Madule far Microsoft Message Cueus

..... o] [T PATROL Knowledge Module for Microsoft MNetwark Load Balancing

..... ] W PATROL Knowledge Maodule for Microsoft Windows Active Directary
..... o] I PATROL Knowledge Maodule for Microsoft Windows Domain Senvices
..... o] W PATROL Knowledge Module for Microsoft Windows Operating System
..... o] W PATROL Knowledge Maodule far Onekey Usage

..... ] W PATROL Wizard for Microsoft Pedformance Manitar and Wbl

. __q|7 PATHOL Reporting and Lltilities

..... :2J I PATROL Adapter far Microsoft Office

..... ] W PATROL Adapter far Microsoft Office - Server Report Templates
..... o] [ PATROL Cluster Configuration Wizard
..... ] [T PATROL Service Reporting Event Retriever
..... b I PATROL Service Reporting History Retriever

10. In the Provide the PATROL 7.x Product Directory, identify the BMC
productsinstallation Directory and the PATROL 7.x product
Directory (you will seethisdiaog only if you selected Common
Servicesin Step 6 of this procedure).

11. Complete the remaining dialog boxes.

Note
The number and contents of the dialog boxes depend on your KM
selections and your inputs to the dialog boxes. Click Help, as needed, to
compl ete the dialog boxes.
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Migration

PATROL KM for Active Directory 1.5.00 has ho migration path from
versions prior to 1.5.00.

Note
Upon installation on a server that has the PATROL for Domain KM

1.3.00, 1.4.00, or 1.4.01already installed, the Domain KM application
classes that are named NT_AD<name> are automatically disabled. These
disabled application class names are recorded in the configuration
database, pconfig, in the location /Agent Setup/disabledK M s.

Where to Go from Here

The components that you installed as part of the Typical installation are
aready configured to preload. The KMsthat you installed individually
are not configured to preload. Before you can begin using any
individually installed KMs, you must load these KMs into the PATROL
Console. For more information, see Chapter 3, “Loading and Configuring
PATROL KM for Active Directory.”
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Loading and Configuring PATROL KM
for Active Directory

This chapter describes how to load, unload, and configure the PATROL
KM for Active Directory product using the PATROL Consoles.

The following topics are discussed in this chapter:

Loading and Unloading KnowledgeModules . ................. 32
Loading KnowledgeModules . .......................... 3-2
Unloading KnowledgeModules .. ....................... 3-6

ConfigUIiNg. ..o e 39
Verifying that Windows Server Objects Are Discovered. . . . ... 39
Accessing KM ApplicationClassMenus . ................. 39
Configuring Windows Event Log Monitoring. . ............. 3-10
Monitoring DriveSpace. ... ..ot 311
ActivatingParameters . ........... ..o i 311

Application Classes . .. ..o 312
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Loading and Unloading Knowledge Modules

Installing PATROL KM for Active Directory places the application files
into the PATROL Directory. You can load the files into the PATROL
Console so that the PATROL KM for Active Directory applications,
commands, and parameters appear in the PATROL Console.

If you no longer want to use an application class that you previously
loaded, you can use the unload instructions to unload the .km file so that
its application class will no longer appear in your console.

Loading Knowledge Modules

Summary:

Before you can begin using Knowledge Modules (KMs) that you have
installed, you must first load them with a PATROL Console. In this
section, follow the instructions that apply to your console.

Loading KMs with PATROL Central - Windows Edition

Step 1

Step 2

Step 3

PATROL Central - Windows Edition has a Loading KMs wizard that
enables you to control which KMs are loaded on which computers.

On the Common Tasks tab of the taskpad, click the Load K nowledge
Modulesicon.

PATROL Central - Windows Edition displays the wizard.
Click Next to start the wizard.

The wizard lists each computer on which a PATROL Agent has been
installed.

Select the check boxes for the computers on which you want to load
KMs, and click Next.

Thewizard displays alist of available .kml files for each computer
selected in the previous step. Each .kml fileislisted once for each
computer. You can display .km files by changing the filter.
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The KMs available in this product are listed in Table 3-1 on page 3-3.

Note
Unless you are an advanced PATROL user, use the .kml filesto load
product component files. Loading individual .km files can break the
interdependencies between the .km files, while loading .kml files
preserves these dependencies.

Table 3-1 Predefined Configuration Components (same for all consoles)

.kml file Component

MWD_ACTIVE_Directory  MN.kml AD_AD_SERVER.km
AD_AD_ADDRESS_BOOK.km
AD_AD_FSMO_ROLE_CONECTIVITY_CONT.km
AD_AD FSMO_ROLE_CONECTIVITY.km
AD_AD_LDAPkm

AD_AD_REPLICATION.km

AD_AD_SAM.km

AD_AD_COLLECTOR.km

Step 4  Sdect the check boxes for the KM and computer pair that you want to
load.

Step 5  Click Next and click Finish.

PATROL loads the selected KMs on the selected computers.

Loading KMs with PATROL Central - Web Edition

PATROL Central - Web Edition has a Loading KMs feature that enables
you to control which KMs are loaded on which computers.

Step 1  From the Monitored Systems page, click the L oad/Unload K M s button.

The Load KM s page opens, listing each computer on which a PATROL
Agent has been installed.

Step 2 Sdect the computers on which you want to load KMs, and click Next.
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Step 3

Step 4

The Load KMs page displays alist of available .km and .kml files.

If you selected more than one computer, the only .km and .kml files that
are listed are the ones that have been installed on all of the selected
computers. If aparticular .km or .kml file wasinstalled only on one
computer, you must choose that computer by itself to load thefile.

The KMs available in this product are listed in Table 3-1 on page 3-3.

Note
Unless you are an advanced PATROL user, use the .kml files to load
product component files. Loading individual .km files can break the
interdependencies between the .km files, while loading .kml files
preserves these dependencies.

Sdlect the .km or .kml files that you want to load.
Click Finish.

PATROL loads the selected KMs on the selected computers.

Note
If you want to load a .km or .kml file that was not listed in Step 2, ensure
that the KM isinstalled on the appropriate computer and select only that
computer in Step 2.
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Loading KMs with the PATROL Console for Windows

Step 1

Step 2

From the PATROL Console for Windows menu bar, choose File => L oad
KM.

The Load KMsdialog box displaysalist of available .kml files. The KMs
available in this product are listed in Table 3-1 on page 3-3.

Note
Unless you are an advanced PATROL user, use the .kml filesto load
product component files. Loading individual .km files can break the
interdependencies between the .km files, while loading .kml files
preserves these dependencies.

Select one or more of the .kml files, and click Open.

PATROL loads the selected KMs on all of the computers listed under
PATROLMainMap.

Loading KMs with the PATROL Console for Unix

Step 1

Step 2

From the PATROL Console for Unix menu bar, choose File=> Load KM.

The Load KMsdialog box displaysalist of available .kml files. The KMs
available in this product are listed in Table 3-1 on page 3-3.

Note
Unless you are an advanced PATROL user, use the .kml filesto load
product component files. Loading individual .km files can break the
interdependencies between the .km files, while loading .kml files
preserves these dependencies.

Select one or more of the .kml files and click Open.

PATROL loads the selected KMs on all of the computers to which your
console is connected.
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Unloading Knowledge Modules

Summary:

If you no longer want to use an application class that you previously
loaded, you can unload the .km file so that its application class will no
longer appear in your console. In some consoles, unloading isreferred to
as deleting. When you unload or delete a.km file using a console, the file
is not deleted from the patrol\knowledge directories on the PATROL
Console or the PATROL Agent computers.

Unloading KMs with PATROL Central - Windows Edition

Step 1

Step 2

Step 3

Step 4

Step 5

PATROL Central - Windows Edition has awizard that enables you to
unload specified .km files from specified computers.

On the Common Tasks tab of the taskpad, click the Unload K nowledge
Modulesicon.

PATROL Central - Windows Edition displays the wizard.
Click Next to start the wizard.

The wizard lists each computer on which a PATROL Agent has been
installed.

Sdlect the check boxes for the computers from which you want to unload
.km files, and click Next.

The wizard displays alist of application class names (that correspond to
.km file names) for each computer selected. Each application class name
islisted once for each computer.

Sdlect the check boxes for the .km and computer pair that you want to
unload, and click Next.

Click Finish.

The console removes the selected .km files from the current management
profile.
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Unloading KMs with PATROL Central - Web Edition

Step 1

Step 2

Step 3

Step 4

PATROL Central - Web Edition has a feature that enables you to unload
specified .km files from specified computers.

From the Managed Systems page, click the L oad/Unload KM s button.

The Load KMs page opens, listing each computer on which a PATROL
Agent has been installed.

Sdlect the computers from which you want to unload .km files, and click
Next.

The Load KMs page displays alist of .km files. Currently loaded .km
files are highlighted in the list.

Cancel the selection of the .km files that you want to unload.
Click Finish.

The console removes the .km files that you specified. These .km files will
no longer bein the current management profile.

Unloading KMs with the PATROL Console for Windows

Step 1

Step 2

Unloading aKM isalso referred to as deleting a KM in the PATROL
Console for Windows.

From the KM tab of the tree view, right-click the application class name
that you want to delete and choose Delete from the pop-up menu.

The console displays adialog box that asks if you want to delete the
selected application.

Click Yesto delete the application class.

The application classis removed from your cache Directory and your
console session file.
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Step 3

Step 4

Repeat Step 1 and Step 2 until you have deleted all of the application
classes associated with the KM that you want to delete.

From the console menu bar, choose File => Save KM to save your
changes.

Unloading KMs with the PATROL Console for Unix

Step 1

Step 2

Step 3

Step 4

Step 5

Unloading aKM is also referred to as deleting a KM in the PATROL
Console for Unix.

From the PATROL Main window, choose Attributes => Application
Classes.

The console displays the List of Application Classes window.

Click the name of the application class that you want to delete.

The console highlights the application class name.

From the List of Application Classes menu bar, choose Edit => Delete.
The application class is removed from your cache Directory and your
console session file. The PATROL Console for Unix removes the

application class name from the List of Application Classes.

Repeat Step 2 and Step 3 until you have deleted all of the application
classes associated with the KM that you want to delete.

From the List of Application Classes menu bar, choose File => Save KM
to save your changes.
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Configuring

The following section describes how to configure PATROL KM for
Active Directory.

Verifying that Windows Server Objects Are Discovered

To ensure that all Windows servers and associated instances are
discovered and online, verify that the Product Name applicationiconis
displayed.

Refer to specific component online Help for alist of the Product Name
component icons. See Appendix A, “Accessing Online Help.”

Note
If theicons do not appear within 15 minutes of startup, open and read the
information in the PATROL system output window.

Accessing KM Application Class Menus

You access KM application class menus slightly differently in each
PATROL Console.

Table 3-2  Accessing KM Menu Commands

Console Method

PATROL Console for Microsoft | Right-click the application icon and choose
Windows Servers KM Commands.

PATROL Console for Unix Right-click the application icon.
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Table 3-2  Accessing KM Menu Commands

Console Method
PATROL Central Operator - In the navigation pane, right-click a managed
Windows Edition system or application icon and choose

Knowledge Module Commands from the
pop-up menu.

PATROL Central Operator - In the tree view area, right-click a managed
Web Edition system, application class, or application
instance, and choose Knowledge Module
Commands from the pop-up menu.

Configuring Windows Event Log Monitoring

»

With the PATROL KM for Windows OS, you can monitor for specific
Windows event IDs or event text. You can create event filters that specify
the type of eventsto monitor and how to monitor them. You can create
event filters by

e selecting events that you want to monitor from the event viewer

» creating anew filter that specifies the types of eventsthat you want to
monitor

Note

PATROL KM for Active Directory requires that the Event Log
component of PATROL KM for Microsoft Windows Servers 3.8.00 is
active. By default the Event Log component isinactive. Refer to the
PATROL KM for Microsoft Windows Servers 3.8.00 documentation to
activate the Event Log component.

To begin configuring event log monitoring, right-click the
NT_EVENTLOG application, and choose the following menu command:

e KM Commands=> Configure Windows Event Filter
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Monitoring Drive Space

PATROL KM for Active Directory monitors
« disk space used by Microsoft Windows 2000 Active Directory

e gpace available on the drive where Microsoft Windows 2000 Active
Directory isinstalled

Activating Parameters

To reduce the impact on your system resources and enhance
performance, parameters that are not commonly needed are turned off by
default. A list of these inactive parametersis provided in the online Help.
From the console menu, choose Help => Help Topics=> PATROL
Knowledge Modules=> PATROL KM for Active Directory => Parameters
=> | nactive by Default.

To activate any of these parameters, use a Developer Console and follow
the instructions below:

PATROL Console for Windows

1. Find the parameter on the KM treein the application class's
\Global\Par ameters folder.

2. Right-click the parameter, and choose Properties from the pop-up
menu.

3. Click Active to check the box.
PATROL Console for Unix

1. Choose Attributes=> Application Classes from the menu bar.
2. Sdect the application class, and choose Attributes => Parameters.

3. Select one or more parameters, and choose Options => Activate.
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Application Classes

The PATROL KM for Active Directory application classes, see Table 3-1
on page 3-3, load automatically when PATROL KM for Active Directory
starts. The kml file, MWD_ACTIVE_Directory MN.kml, contains thelist
of the KMs that will load automatically.

Table 3-3  Application Classes and Descriptions

Application Class

Description

AD_AD_SERVER

This application class represents a domain controller
instance. There will be one instance per discovered
domain controller. The instance is named “Active
Directory Server.”

AD_AD_ADDRESS_BOOK

This application class represents the address book on
an active Directory server. It monitors the performance
of Address Book requests made against the Active
Directory server. Each instance is named “Address
Book.”

AD_AD_LDAP This application class monitors the performance of
LDAP requests made against the Active Directory
server. The instance is named “LDAP Performance.”

AD_AD_SAM This application class monitors the performance of SAM

requests made against the Active Directory server. SAM
requests are generated when an NT 4.0 client of a
Windows 2000 Active Directory server initiates an
account change request. The instance is named “SAM
Performance.”

AD_AD_REPLICATION

This application class monitors the performance of
Active Directory replication for the enterprise. The single
instance will be named “Replication Performance.”

AD_AD_FSMO_ROLE_CONNECTIVITY

Domain controllers must be able to locate and establish
a LDAP connection with FSMO role holders. This
application class monitors the connectivity status of each
of the five FSMO role holders from this domain
controller. The single instance is named “FSMO
Connectivity”

AD_AD_COLLECTOR.km

This application class is the parent for all parameter
collectors except FSMO. The instance is “Collectors.”
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Accessing Menu Commands,
InfoBoxes, and Online Help

BMC Software offers several PATROL consoles from which you can
view a PATROL Knowledge Module (KM). Because of the different
environments in which these consoles run, each one uses a different
method to display and access information in the KM. This appendix
provides instructions for accessing the KM menu commands, InfoBoxes,
and online Help on each of the PATROL consoles. See the PATROL KM
for Active Directory online Help for more detailed information about
navigation in the PATROL Consoles.

Accessing KM Commands and InfoBoxes. . .. ................ A-2
Accessing OnlineHelp. ... A-3
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Accessing KM Commands and InfoBoxes

Table A-1 provides information about how to access KM commands and
InfoBoxes from the various PATROL consoles.

Table A-1  Accessing KM Commands and InfoBoxes
To access To access
Console menu commands InfoBoxes

PATROL Console for Microsoft
Windows Servers

In either the Desktop tree tab
or work area, right-click a
computer or application icon
and choose KM Commands
from the pop-up menu.

In either the Desktop tree tab
or the work area, right-click an
application class or parameter
icon and choose InfoBox from
the pop-up menu.

PATROL Console for Unix

In the work area, right-click a
computer or application icon to
display a pop-up menu that
contains KM-specific
commands.

With the middle mouse button,
click an application class or
parameter icon.

PATROL Central Operator -
Windows Edition

In the navigation pane,
right-click a managed system or
application icon and choose
Knowledge Module
Commands from the pop-up
menu.

In the navigation pane,
right-click a PATROL object and
choose InfoBox from the
pop-up menu.

PATROL Central Operator -
Web Edition

In the tree view area, right-click
an application icon and choose
Knowledge Module
Commands from the pop-up
menu.

In the tree view area, right-click
a PATROL object and choose
Infobox from the pop-up menu.
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Accessing Online Help

Table A-2 provides information about how to access Help from each
console.

Note
If you are trying to access Help from a Unix console, see the PATROL
Installation Reference Manual for specific instructions about installing
and setting up a browser in the Unix environment.

Table A-2  Accessing Online Help (Part 1 of 2)

To access
To access application class To access
Console product help help parameter help
PATROL Console * Right-click the Double-click an * Right-click a
for Microsoft PATROL KM for application class in the parameter icon and
Windows Servers Active Directory KM tab of the console. choose Help On from
application icon and From the Application the pop-up menu.
choose KM Properties dialog box, * Double-click a
Commands => click the Help tab. Then parameter icon; click

Product Help. the ? icon or Help

click Show Help.

* From the console

menu bar, choose
Help => Help Topics
=> PATROL
Knowledge
Modules.

button in the
parameter display
window.

» Double-click a
parameter in the KM
tab of the console;
from the properties
dialog box, click the
Help tab; then click
Show Help.

PATROL Console
for Unix

Right-click the
PATROL KM for
Active Directory
application icon and
choose KM
Commands =>
Product Help.
From the console
menu bar, choose
Help On =>
Knowledge
Modules.

Choose Attributes =>
Application Classes
and double-click the
application name. Click
Show Help in the
Application Definition
dialog box.

Right-click a parameter
icon and click Help On.
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Table A-2

Accessing Online Help (Part 2 of 2)

Console

To access
product help

To access
application class
help

To access
parameter help

PATROL Central
Operator - Windows
Edition

From the console menu
bar, choose Help =>
Help Topics. In the
Contents tab, click the
name of your product.

In the Operator tab of
the navigation pane,
select an application
icon and press F1.

In the Operator tab of
the navigation pane,
select a parameter icon
and press F1.

PATROL Central
Operator - Web
Edition

In the upper right corner
of PATROL Central, click
Help and choose
PATROL KM Help.

In the tree view,
right-click an application
class and choose Help.

In the tree view,
right-click a parameter
and choose Help.
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Agent Configuration Variables

This section describes the PATROL KM for Active Directory agent
configuration variables that are set in the PATROL Agent. To view these
variables, use BMC Software’'s ChangeSpring product, the wpconfig
utility, or the PATROL Configuration Manager.

Warning
Changing any of these variables can prevent some functions from
working properly and can affect your entire installation. Before you
change a variable, make arecord of the original setting.

Managing Configuration Variables. . ......................... B-2
PATROL KM for Active Directory Configuration Variables. . . .. .. B-2
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Managing Configuration Variables

BMC Software recommends that you set and view agent configuration
variables by using ChangeSpring. Using PATROL Configuration
Manager or the wpconfig utility to view variable settings or deploy them
to other machines is acceptable, but is not as convenient as using

ChangeSpring.

Warning

Do not use the wpconfig utility or PATROL Configuration Manager to
remove variables or add new variables. Doing so may prevent some
functions from working properly and can affect your entire installation.

PATROL KM for Active Directory Configuration
Variables

Table B-1 lists the PATROL KM for Active Directory variable settings.

Table B-1  Configuration Variables for PATROL KM for Active Directory (Part 1 of 2)

Variable Description Location Type

SchemaMasterConnsSt | interval for checking LDAP connectivity to ActiveDirectory/ | integer
atusSched the domain controller that is the FSMO Configuration
Schema Master (unit is seconds, default
value is 43,200 [12 hours])

DomainNamingMaster | interval for checking LDAP connectivity to ActiveDirectory/ | integer
ConnStatusSched the domain controller that is the FSMO Configuration
Domain Naming Master (unit is seconds,
default value is 43,200 [12 hours])

RelativeIDMasterConn | interval for checking LDAP connectivity to ActiveDirectory/ | integer
StatusSched the domain controller that is the FSMO Configuration
Relative ID Master (unit is seconds, default
value is 3,600 [1 hour])

InfrastructureMasterC | interval for checking LDAP connectivity to ActiveDirectory/ | integer
onnStatusSched the domain controller that is the FSMO Configuration
Infrastructure Master (unit is seconds,
default value is 3,600 [1 hour])
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Table B-1

Configuration Variables for PATROL KM for Active Directory (Part 2 of 2)

Variable Description Location Type
PDCEmulatorConnSta | interval for checking LDAP connectivity to ActiveDirectory/ | integer
tusSched the domain controller that is the FSMO Configuration
PDC Emulator (unit is seconds, default
value is 3,600 [1 hour])
DisableAnnotations enables/disables all PATROL for Active ActiveDirectory/ | boolean
Directory parameter annotation (by default | Configuration
annotation is enabled—to disable
annotation for all PATROL KM for Active
Directory parameters, add this variable to
pconfig and set the value to 1)
<fully-qualified-server | provides a way to configure (on a ActiveDirectory/ | integer
name>_PingTimeout per-server basis) the timeout that is used Configuration
Example: when a server is pinged for
name.bmc.com_PingT | availability—servers that are connected via
imeout a slower link may need this value
increased (unit is milliseconds, default is
5,000)
<fully-qualified-server | provides a way to configure (on a ActiveDirectory/ | integer

name>_PingCount
Example:
name.bmc.com_Ping
Count

per-server basis) the number of times that
a server is “pinged” to test its
availability—servers that are connected via
a slower link may need this value
increased (a server is considered available
if any one ping is successful) (unit is
number of pings, default is 3)
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END USER LICENSE AGREEMENT
NOTICE

BY OPENING THE PACKAGE, INSTALLING, PRESSING “AGREE” OR “YES” OR USING THE PRODUCT, THE ENTITY OR
INDIVIDUAL ENTERING INTO THIS AGREEMENT AGREES TO BE BOUND BY THE FOLLOWING TERMS. IF YOU DO NOT
AGREE WITH ANY OF THESE TERMS, DO NOT INSTALL OR USE THE PRODUCT, PROMPTLY RETURN THE PRODUCT TO
BMC OR YOUR BMC RESELLER, AND IF YOU ACQUIRED THE LICENSE WITHIN 30 DAYS OF THE DATE OF YOUR ORDER
CONTACT BMC OR YOUR BMC RESELLER FOR A REFUND OF LICENSE FEES PAID. IF YOU REJECT THIS AGREEMENT, YOU
WILL NOT ACQUIRE ANY LICENSE TO USE THE PRODUCT.

This Agreement (“Agreement”) is between the entity or individual entering into this Agreement (“You”) and BMC Software Distribution,
Inc., a Delaware corporation located at 2101 CityWest Blvd., Houston, Texas, 77042, USA or its affiliated local licensing entity (‘BMC”).
“You” includes you and your Affiliates. “Affiliate” is defined as an entity which controls, is controlled by or shares common control with a
party. IF MORE THAN ONE LICENSE AGREEMENT COULD APPLY TO THE PRODUCT, THE FOLLOWING ORDER OF LICENSE
AGREEMENT PRECEDENCE APPLIES: (1) WEB BASED LICENSE AGREEMENT WITH BMC, (2) WRITTEN LICENSE
AGREEMENT WITH BMC, (3) SHRINK-WRAP LICENSE AGREEMENT WITH BMC PROVIDED WITH THE PRODUCT, AND (4)THIS
ELECTRONIC LICENSE AGREEMENT WITH BMC. In addition to the restrictions imposed under this Agreement, any other usage
restrictions contained in the Product installation instructions or release notes shall apply to Your use of the Product.

PRODUCT AND CAPACITY. “Software” means the object code version of the computer programs provided, via delivery or electronic
transmission, to You. Software includes computer files, enhancements, maintenance modifications, upgrades, updates, bug fixes, and
error corrections.

“Documentation” means all written or graphical material provided by BMC in any medium, including any technical specifications,
relating to the functionality or operation of the Software.

“Product” means the Software and Documentation.

“License Capacity” means the licensed capacity for the Software with the pricing and other license defining terms, including capacity
restrictions, such as tier limit, total allowed users, gigabyte limit, quantity of Software, and/or other capacity limitations regarding the
Software. For licenses based on the power of a computer, You agree to use BMC'’s current computer classification scheme, which is
available at http://www.bmc.com or can be provided to You upon request.

ACCEPTANCE. The Product is deemed accepted by You, on the date that You received the Product from BMC.

LICENSE. Subject to the terms of this Agreement, as well as Your payment of applicable fees, BMC grants You a non-exclusive,
non-transferable, perpetual (unless a term license is provided on an order) license for each copy of the Software, up to the License
Capacity, to do the following:

(a) install the Software on Your owned or leased hardware located at a facility owned or controlled by You in the country where You
acquired the license;

(b) operate the Software solely for processing Your own data in Your business operations; and

(c) make one copy of the Software for backup and archival purposes only (collectively a “License”).

If the Software is designed by BMC to permit you to modify such Software, then you agree to only use such modifications or new
software programs for Your internal purposes or otherwise consistent with the License. BMC grants You a license to use the
Documentation solely for Your internal use in Your operations.

LICENSE UPGRADES. You may expand the scope of the License Capacity only pursuant to a separate agreement with BMC for such
expanded usage and Your payment of applicable fees. There is no additional warranty period or free support period for license
upgrades.

RESTRICTIONS: You agree to NOT:

(a) disassemble, reverse engineer, decompile or otherwise attempt to derive any Software from executable code;

(b) distribute or provide the Software to any third party (including without limitation, use in a service bureau, outsourcing environment,
or processing the data of third parties, or for rental, lease, or sublicense); or

(c) provide a third party with the results of any functional evaluation or benchmarking or performance tests, without BMC'’s prior written
approval, unless prohibited by local law.



TRIAL LICENSE. If, as part of the ordering process, the Product is provided on a trial basis, then these terms apply: (i) this license
consists solely of a non-exclusive, non-transferable evaluation license to operate the Software for the period of time specified from BMC
or, if not specified, a 30 day time period (“ Trial Period”) only for evaluating whether You desire to acquire a capacity-based license to
the Product for a fee; and (ii) Your use of the Product is on an AS IS basis without any warranty, and BMC, ITS AFFILIATES AND
RESELLERS, AND LICENSORS DISCLAIM ANY AND ALL WARRANTIES (INCLUDING, WITHOUT LIMITATION, THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT) AND HAVE NO
LIABILITY WHATSOEVER RESULTING FROM THE USE OF THIS PRODUCT UNDER THIS TRIAL LICENSE (“Trial License”).
BMC may terminate for its convenience a Trial License upon notice to You. When the Trial Period ends, Your right to use this Product
automatically expires. If You want to continue Your use of the Product beyond the Trial Period, contact BMC to acquire a
capacity-based license to the Product for a fee.

TERMINATION. This Agreement shall immediately terminate if You breach any of its terms. Upon termination, for any reason, You must
uninstall the Software, and either certify the destruction of the Product or return it to BMC.

OWNERSHIP OF THE PRODUCT. BMC or its Affiliates or licensors retain all right, title and interest to and in the BMC Product and all
intellectual property, informational, industrial property and proprietary rights therein. BMC neither grants nor otherwise transfers any
rights of ownership in the BMC Product to You. Products are protected by applicable copyright, trade secret, and industrial and
intellectual property laws. BMC reserves any rights not expressly granted to You herein.

CONFIDENTIAL AND PROPRIETARY INFORMATION. The Products are and contain valuable confidential information of BMC
(“Confidential Information”). Confidential Information means non-public technical and non-technical information relating to the
Products and Support, including, without limitation, trade secret and proprietary information, and the structure and organization of the
Software. You may not disclose the Confidential Information to third parties. You agree to use all reasonable efforts to prevent the
unauthorized use, copying, publication or dissemination of the Product.

WARRANTY. Except for a Trial License, BMC warrants that the Software will perform in substantial accordance with the Documentation
for a period of one year from the date of the order. This warranty shall not apply to any problems caused by software or hardware not
supplied by BMC or to any misuse of the Software.

EXCLUSIVE REMEDY. BMC's entire liability, and Your exclusive remedy, for any defect in the Software during the warranty period or
breach of the warranty above shall be limited to the following: BMC shall use reasonable efforts to remedy defects covered by the
warranty or replace the defective Software within a reasonable period of time, or if BMC cannot remedy or replace such defective copy
of the Software, then BMC shall refund the amount paid by You for the License for that Software. BMC's obligations in this section are
conditioned upon Your providing BMC prompt access to the affected Software and full cooperation in resolving the claim.

DISCLAIMER. EXCEPT FOR THE EXPRESS WARRANTIES ABOVE, THE PRODUCT IS PROVIDED “AS IS’ BMC, ITS
AFFILIATES AND LICENSORS SPECIFICALLY DISCLAIM ALL OTHER WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT. BMC
DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT
ALL DEFECTS CAN BE CORRECTED.

DISCLAIMER OF DAMAGES. IN NO EVENT IS BMC, ITS AFFILIATES OR LICENSORS LIABLE FOR ANY SPECIAL, INDIRECT,
INCIDENTAL, PUNITIVE OR CONSEQUENTIAL DAMAGES RELATING TO OR ARISING OUT OF THIS AGREEMENT, SUPPORT,
AND/OR THE PRODUCT (INCLUDING, WITHOUT LIMITATION, LOST PROFITS, LOST COMPUTER USAGE TIME, AND DAMAGE
OR LOSS OF USE OF DATA), EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND IRRESPECTIVE OF ANY
NEGLIGENCE OF BMC OR WHETHER SUCH DAMAGES RESULT FROM A CLAIM ARISING UNDER TORT OR CONTRACT
LAW.

LIMITS ON LIABILITY. BMC'S AGGREGATE LIABILITY FOR DAMAGES IS LIMITED TO THE AMOUNT PAID BY YOU FOR THE
LICENSE TO THE PRODUCT.

SUPPORT. If Your order includes support for the Software, then BMC agrees to provide support (24 hours a day/7 days a week)
(“Support”). You will be automatically re-enrolled in Support on an annual basis unless BMC receives notice of termination from You
as provided below. There is a free support period during the one year warranty period.

(a) Support Terms. BMC agrees to make commercially reasonable efforts to provide the following Support: (i) For malfunctions of
supported versions of the Software, BMC provides bug fixes, patches or workarounds in order to cause that copy of the Software to
operate in substantial conformity with its then-current operating specifications; and (ii) BMC provides new releases or versions, so long
as such new releases or versions are furnished by BMC to all other enrolled Support customers without additional charge. BMC may
refuse to provide Support for any versions or releases of the Software other than the most recent version or release of such Software
made available by BMC. Either party may terminate Your enrollment in Support upon providing notice to the other at least 30 days prior
to the next applicable Support anniversary date. If You re-enroll in Support, BMC may charge You a reinstatement fee of 1.5 times what
You would have paid if You were enrolled in Support during that time period.

(b) Fees. The annual fee for Support is 20% of the Software’s list price less the applicable discount or a flat capacity based annual fee.
BMC may change its prices for the Software and/or Support upon at least 30 days notice prior to Your support anniversary date.



VERIFICATION. If requested by BMC, You agree to deliver to BMC periodic written reports, whether generated manually or
electronically, detailing Your use of the Software in accordance with this Agreement, including, without limitation, the License Capacity.
BMC may, at its expense, perform an audit, at your facilities, of Your use of the Software to confirm Your compliance with the
Agreement. If an audit reveals that You have underpaid fees, You agree to pay such underpaid fees. If the underpaid fees exceed 5% of
the fees paid, then You agree to also pay BMC's reasonable costs of conducting the audit.

EXPORT CONTROLS. You agree not to import, export, re-export, or transfer, directly or indirectly, any part of the Product or any
underlying information or technology except in full compliance with all United States, foreign and other applicable laws and regulations.

GOVERNING LAW. This Agreement is governed by the substantive laws in force, without regard to conflict of laws principles: (a) in the
State of New York, if you acquired the License in the United States, Puerto Rico, or any country in Central or South America; (b) in the
Province of Ontario, if you acquired the License in Canada (subsections (a) and (b) collectively referred to as the “ Americas Region”);
(c) in Singapore, if you acquired the License in Japan, South Korea, Peoples Republic of China, Special Administrative Region of Hong
Kong, Republic of China, Philippines, Indonesia, Malaysia, Singapore, India, Australia, New Zealand, or Thailand (collectively, “ Asia
Pacific Region”); or (d) in the Netherlands, if you acquired the License in any other country not described above. The United Nations
Convention on Contracts for the International Sale of Goods is specifically disclaimed in its entirety.

ARBITRATION. ANY DISPUTE BETWEEN YOU AND BMC ARISING OUT OF THIS AGREEMENT OR THE BREACH OR
ALLEGED BREACH, SHALL BE DETERMINED BY BINDING ARBITRATION CONDUCTED IN ENGLISH. IF THE DISPUTE IS
INITIATED IN THE AMERICAS REGION, THE ARBITRATION SHALL BE HELD IN NEW YORK, U.S.A., UNDER THE CURRENT
COMMERCIAL OR INTERNATIONAL, AS APPLICABLE, RULES OF THE AMERICAN ARBITRATION ASSOCIATION. IF THE
DISPUTE IS INITIATED IN A COUNTRY IN THE ASIA PACIFIC REGION, THE ARBITRATION SHALL BE HELD IN SINGAPORE,
SINGAPORE UNDER THE CURRENT UNCITRAL ARBITRATION RULES. IF THE DISPUTE IS INITIATED IN A COUNTRY
OUTSIDE OF THE AMERICAS REGION OR ASIA PACIFIC REGION, THE ARBITRATION SHALL BE HELD IN AMSTERDAM,
NETHERLANDS UNDER THE CURRENT UNCITRAL ARBITRATION RULES. THE COSTS OF THE ARBITRATION SHALL BE
BORNE EQUALLY PENDING THE ARBITRATOR'S AWARD. THE AWARD RENDERED SHALL BE FINAL AND BINDING UPON
THE PARTIES AND SHALL NOT BE SUBJECT TO APPEAL TO ANY COURT, AND MAY BE ENFORCED IN ANY COURT OF
COMPETENT JURISDICTION. NOTHING IN THIS AGREEMENT SHALL BE DEEMED AS PREVENTING EITHER PARTY FROM
SEEKING INJUNCTIVE RELIEF FROM ANY COURT HAVING JURISDICTION OVER THE PARTIES AND THE SUBJECT MATTER
OF THE DISPUTE AS NECESSARY TO PROTECT EITHER PARTY’'S CONFIDENTIAL INFORMATION, OWNERSHIP, OR ANY
OTHER PROPRIETARY RIGHTS. ALL ARBITRATION PROCEEDINGS SHALL BE CONDUCTED IN CONFIDENCE, AND THE
PARTY PREVAILING IN ARBITRATION SHALL BE ENTITLED TO RECOVER ITS REASONABLE ATTORNEYS' FEES AND
NECESSARY COSTS INCURRED RELATED THERETO FROM THE OTHER PARTY.

U.S. GOVERNMENT RESTRICTED RIGHTS. The Software under this Agreement is “commercial computer software” as that term is
described in 48 C.FR. 252.227-7014(a)(1). If acquired by or on behalf of a civilian agency, the U.S. Government acquires this
commercial computer software and/or commercial computer software documentation subject to the terms of this Agreement as
specified in 48 C.F.R. 12.212 (Computer Software) and 12.211 (Technical Data) of the Federal Acquisition Regulations (“ FAR") and its
successors. If acquired by or on behalf of any agency within the Department of Defense (“DOD”), the U.S. Government acquires this
commercial computer software and/or commercial computer software documentation subject to the terms of this Agreement as
specified in 48 C.F.R. 227.7202 of the DOD FAR Supplement and its successors.

MISCELLANEOUS TERMS. You agree to pay BMC all amounts owed no later than 30 days from the date of the applicable invoice,
unless otherwise provided on the order for the License to the Products. You will pay, or reimburse BMC, for taxes of any kind, including
sales, use, duty, tariffs, customs, withholding, property, value-added (VAT), and other similar federal, state or local taxes (other than
taxes based on BMC's net income) imposed in connection with the Product and/or the Support. This Agreement constitutes the entire
agreement between You and BMC and supersedes any prior or contemporaneous negotiations or agreements, whether oral, written or
displayed electronically, concerning the Product and related subject matter. No modification or waiver of any provision hereof will be
effective unless made in a writing signed by both BMC and You. You may not assign or transfer this Agreement or a License to a third
party without BMC's prior written consent. Should any provision of this Agreement be invalid or unenforceable, the remainder of the
provisions will remain in effect. The parties have agreed that this Agreement and the documents related thereto be drawn up in the
English language. Les parties exigent que la présente convention ainsi que les documents qui s’y rattachent soient rédigés en anglais.
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